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Lesson 01
Polyline Command

—

% Diraw menw: Polyline

% Draw toolbar:

EE command entry: pline

You may select this command from pull-down menu, draw-toolbar, or type alias “PL”
from the command line.

Insert Format Tools | Draw  Dimension  Modif
Pa®| @ b |
Ray -
£ &m0 *  Conskruckion Line
——  [Mulkiline F

Palyline
30 Polyline
Palygon
Reckangle

Birc ¥
Circle »

S S s o O Qe omm B - B EBEA

Command: pl <Enter>

Specify start point: 2,2 <Enter>

Current line-width is 0.0000

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: w <Enter>
Specify starting width <0.0000>: 0.1 <Enter>

Specify ending width <0.1000>: <Enter>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 5,1  <Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @1.5<90 <Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @3.5,0 <Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @2.5<120 <Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @5<180 <Enter>
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Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: C

<Enter>.

Exercise Polyline (ARC)

Start AutoCAD and open the my_template52 file.

Command: pl <Enter>

PLINE

Specify start point: 5.25,4 <Enter>

Current line-width is 0.0000

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: w <Enter>

Specify starting width <0.0000>: 0.1  <Enter>

Specify ending width <0.1000>; <Enter>

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: @2<0 <Enter>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: a <Enter>

Specify endpoint of arc or

[Angle/CEnter/CLose/Direction/Halfwidth/Line/Radius/Second pt/Undo/Width]: @1<90
<Enter>

Specify endpoint of arc or

[Angle/CEnter/CLose/Direction/Halfwidth/Line/Radius/Second  pt/Undo/Width]: ~ @2.5<90
<<Enter>

Specify endpoint of arc or

[Angle/CEnter/CLose/Direction/Halfwidth/Line/Radius/Second pt/Undo/Width]: L <Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @.5<90 <Enter>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @2<180 <Enter>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <Enter>
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Figure 1 Figure 2

Use the MIRROR Command to complete the figure.

Command: mirror <Enter>

Select objects: {Pick the polyline} 1 found

Select objects: <Enter>

Specify first point of mirror line: {Snap to point 1} Specify second point of mirror line: {Snap
to point 2}

Erase source objects? [Yes/No] <N>: <Enter>




EXERCISE 1-2

sall sk Le="za” 75|,

it

LB

CONTOUR MAP B.

Figure 1

0+00 -
| 0+20
| o
| o+6o -
| 080

- 1+a0

AutoCAD Workbook Il

. FLINE-with "Fill"' option off
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Use the PLINE Command to draw the following objects with a .032 line width. Add dimensions.

EXERCISE 1-3
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EE command line: MLINE

Lesson 2
MULTI - LINE Command

1. From the format select “Mutiline Style (Figure 1)
2. Select the “Modify” tab from the dialog box (Figure 2)

GEGE Tools  Draw  Dimension

¥ =2 Laver...

< 93 Layer States Manager. ..

- Laver tools 4
Calor...
Linetype. ..
Lineweight. ..

Scale List..,

&6 Text Style...
,,ﬁ Dimensian Skyle...

ﬁ Table Style..,
8f Multileader Style

Point Style. ..

rultiling Sk

Uniks...
w# Thickness

Pie zaaiirem | iraike

Figure 1

3. Change the offset
distance for the
multilane
elements to .125
& -.125. (Figure 3

4. Clock the OK tab
to exit the modify,
and click the OK
tab to exit the
Multiline style the
dialog box.

Current Multiline Style: STANDARD

Drezeription:

Freview of: STANDARD

AutoCAD Workbook Il

[ QK. ] ’ Cancel ] [ Help
Figure 2
EX Modify Multiline Style: STANDARD %]
Description: | |
Caps Elements
Start End Offzet Calor Linetype
Line: 0125 BYLAYER  BylLaper
e - - \D@ BYLAYER  BuyLaper
Outer arc: | il
Inner arcs: IFl J
Bngle: oo | (a0 | [ add | [ Delete |
Fil Offzet: ‘]
Fill colar: ||:| More v| R
Calor |. ByLayer v ‘
Display joints: [ ] Linetype: I Linetype. .. l
QK ] ’ Cancel ] ’ Help ]
Figure 3




Command: ml <Enter>

MLINE

Current settings: Justification = Top, Scale = 1.00, Style =
STANDARD

Specify start point or [Justification/Scale/STyle]:J<Enter>
Enter justification type [Top/Zero/Bottom] <top>:Z <Enter>
Current settings: Justification = Zero, Scale = 1.00, Style =
STANDARD

Specify start point or [Justification/Scale/STyle]: {Pick any
point on screen}

Specify next point: <Ortho on> 1.5 <Enter>

Specify next point or [Undo]: 2.5 <Enter>

Specify next point or [Close/Undo]: 1.5 <Enter>

Specify next point or [Close/Undo]: C <Enter> (Figure 4)

Command: ml <Enter>

MLINE

Current settings: Justification = Zero, Scale = 1.00, Style =
STANDARD

Specify start point or [Justification/Scale/STyle]: j <Enter>
Enter justification type [Top/Zero/Bottom] <zero>: b <Enter>
Current settings: Justification = Bottom, Scale = 1.00, Style =
STANDARD

Specify start point or [Justification/Scale/STyle]:

Specify next point: <Ortho on> 1.5 <Enter>

Specify next point or [Undo]: 2.5 <Enter>

Specify next point or [Close/Undo]: 1.5 <Enter>

Specify next point or [Close/Undo]: ¢ <Enter> (Figure 5)

AutoCAD Workbook Il
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Figure 4
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Figure 5
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Command: ml
MLINE : :
Current settings: Justification = Bottom, Scale = 1.00, ~— 1,20 —=
Style = STANDARD

Specify start point or [Justification/Scale/STyle]: j
Enter justification type [Top/Zero/Bottom] <bottom>: t
Current settings: Justification = Top, Scale = 1.00,
Style = STANDARD

Specify start point or [Justification/Scale/STyle]: '
Specify next point: 1.5 =.50
Specify next point or [Undo]: 2.5 - - -
Specify next point or [Close/Undo]: 1.5
Specify next point or [Close/Undo]: ¢

Exercise 2-1

Draw the proposed electrical circuit using multilane commands. Establish a line offset
proportional to the given layout. Use t5he phantom linetype for the center of each run. Do not
draw the grid, which is provided as a drawing aid.

Note: Create a new Multiline Style with the following settings:

New Multiline Style: ROLND_END

Drezcription:
Capz Elements

Start End Color Linetype
Line: BvLAYER  Bywlaver

BYLAYER  PHAMTOM
Outer ar:; BYLAYER  BuwlLaver
Inrer arca:
Angle: 30.00 30.00 sdd | [ Delete |
il Offget: 0125
Fill colar: [] Mone "
Colar: [] BuLaver "
Display joints:  [] Linetype: [ Linetype... ]
ak. l [ Cancel ] [ Help ]
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Exercise 2-2
OFFICE Building Project-

Settings:

Scale : 1/8 “=1"-0"; Scale factor = 96

Limits:

Lower left corner <0'-0",0'-0">; upper right corner <84'-0",64'-0">:
Units: Architectural

“as'lg”
B P 58" ¥-11 1-g" +
: Rl :
& y o *
| | e O ! A | R I
_i i F \ i 5 %
- -QFFICE 2
i B hi
b = = Al . T - .. Ar-o® | . 1.
. AN | TRANING ROOM
!‘i L
b ** g'—1o"
o o FRECEFTION %
wi | | | ENTRE] o w ‘\ o -
p—— " I
" 1 "
N 47 . —
. 4 | . . . L .
4 BT 3§ iy ‘ b= ¥
1
o'+ 15 —F
13—0"

1. From pull_down menu “Format” select Multiline Style, or type MLSTYLE from the
command line. (Fig. 1)

2. Click on the “New™ Tab to create a new style. (Fig. 2), called “Ext Wall” (Fig. 3).
Click on the *““Continue™ tab.

3. Add a new line to this style with green color and 7 as offset distance. Change other lines
to -3 and 3 for the offset distance.(See fig 4)

4. Set this style to the current and click on the OK tab. (Fig 5)

With this Multi Line draw the out side wall.

a1

11
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Format  Tools  Draw  Dimer E Multiline Style
=2 Laver..,
- Current Multiline Style: STANDARD
Colar...
Linetvpe. .. Shiles:
. ) STAMDARD
Lineweight. ..
Scale List. ..
&? Texk Skyle... —
. . Modify. ..
,,.ﬁ Dimension Skyle, ..
ﬁ' Table style. ..
Point Stvle, ., Dezcription:
Multiline Skyle. .. Lzl
Units. ..
; Save..
Figure 1 Fresiew of: STANDARD
k. Cancel Help
Y

Figure 2

&l Create New Multiline Style

Mew Style Nam

Start With:

| Cancel

| Help

Figure 3

12
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Bl New Multitine Style: EX_WALL
Drescription:
Capz E lements
Start End Offzet Color Linetype
Line: I I 7 greenh ByLayer
3 BYLAYER  BulLaver
Oluter arc; B [ -3 ByLAYER  ByLayer
Inner arcs: [ [
Angle: 50.00 50.00 | Delete |
Fil ) Offzet;
Fill colar: [ Mone "
] Colar: []Green (:})
Display joints: |~ Linetype: Linetype. .. |
k. Cancel | Help |
Figure 4
Bl Multiline Style 3
Current Multiling Stple: EXT _WALL
Styles:
T [Gacmi]
Mew...
Dezcrnption:
Load...
Save...
Presiew of: E=T _wall

( ] K-> Cancel Help

Figure 5
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Command: ml <Enter>
MLINE

Current settings: Justification = Top, Scale = 1.00, Style =

EX_WALL

Specify start point or [Justification/Scale/STyle]: 31°,41°

<Enter>

Specify next point: 25' <Enter> {Make sure that ORTHO

mode is set to ON.

Specify next point or [Undo]: 19'8 <Enter>

AutoCAD Workbook Il

Specify next point or [Close/Undo]: 12'8 <Enter> Figure 6
Specify next point or [Close/Undo]: 2'4 <Enter>
Specify next point or [Close/Undo]: 10'4 <Enter>
Specify next point or [Close/Undo]: 8'8 <Enter>
Specify next point or [Close/Undo]: 2'  <Enter>
Specify next point or [Close/Undo]: ¢ <Enter>
Command:
6. Create a new multi line style | Bl Create New Multiline Style
called INT_Wall. (Fig. 6) For
this style, delete the third line New Style Name: | INT_w/al
reen). Fig 7.
€ )-Fig Start Wwith: | Ex_WwALL L
Continue | Cancel Help |
Y
Figure 6
Iﬂ New Multiline Style: INT_WaLL
Drezcription:
Caps Elements
Start End Offzet Color Linetype
Lirie: B r 7 areen ByLayer
3 BYLaYER  BulLayer
Duter arc: N I -3 BYLAYER  ByLayer
Inner arcs: ™ I
anle: 30.00 30.00 sad | (e |
Fill Offset: 7.000
Fill calor: [ Mate v
Color: [ Green “w
Display joints: [~ Linetype: Linetype...
Ok, | Cancel ‘ Help ‘

Figure 7
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7. Add the two interior walls (Fig. 8)
Command: ml <Enter>

MLINE

Current settings: Justification = Top, Scale =
1.00, Style = INT_WALL

Specify start point or
[Justification/Scale/STyle]: j <Enter>

Enter justification type [Top/Zero/Bottom]
<top>: b <Enter>

Current settings: Justification = Bottom, Scale
=1.00, Style = INT_WALL

Specify start point or
[Justification/Scale/STyle]: {shap to the END
point A} Fig. 8

Specify next point: _per to {snap to the
Perpendicular to line B}

Specify next point or [Undo]:

Command: ml <Enter>

MLINE

Current settings: Justification = Bottom, Scale
=1.00, Style = INT_WALL

Specify start point or
[Justification/Scale/STyle]: j <Enter>

Enter justification type [Top/Zero/Bottom]
<bottom>: t <Enter>

Current settings: Justification = Top, Scale =
1.00, Style = INT_WALL
Specify start point or

[Justification/Scale/STyle]: {snap to the End to

line C}
Specify next point: _per to {snap to the
Perpendicular to line D}

7. From the “Modify” pul;_down
menu, Object, select the
multiline. Fig 9.

8. Select the “Open Tee™ option.
Fig 10.

AutoCAD Workbook Il

E
. I
&
Figure 8
Chject External Reference r
Clip Irnage »
5,/{ Erasze ﬁ Hatch...
O% Copy. 6 Polyline
AN Mirrar ¢ spline
di OFfset Multiline. ..
og 4 i 3
oo frray... Akkribuke
Figure 9
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Bl Multilines Edit Tools

AutoCAD Workbook Il

To uze a tool, click on the icon.  Object zelection must be performed after
the tool has been selected.
b ultiines Edit Tools
== == L [
F—— =
L |
Clozed Crosz Clozed Tee Corner Joint Cut Single
== Il
——— = =
- Il
Open Crozz Open Tee Add Yertex Cut Al
I — I
——== | = =
i 1 il
kerged Crozs terged Tee Delete Werteny feld Al
Cloze | Help |
Figure 10
Command: _mledit <Enter> .
Select first mline or [Undo]: {Select the wall C} I
Select second mline: {Select thewallD}  —--- ¥
Select first mline or [Undo]: {Select the wall D}
Select second mline: {Select the wall B}
Select first mline or [Undo]: <Enter>

) ) ) Figure 16
9. Using the insert command or through the “Design center” add

the doors and window shown in figure 11. Use the “Cut All”
or “Cut Single” from multiline edit to complete the project.
10. Add dimensions as shown.

16
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Lesson 3
SPLINE Command

2|

8]
% Spline
B spline
4,4
2,2 6,2
Figure 1

A spline drawn with the SPLINE command.
AutoCAD’s default start and end tangents were
used for this spline

4,4

2,2l f*z

Figure 3

These splines were drawn through the same points,

but they have different start and end tangent
directions. The arrows indicate the tangent
directions.

17

4,4

20 6,2

Figure 2

Using the Close option of the SPLINE
command with AutoCAD default tangents to
draw a closed spline.

Note: Edit the spline (SPE) in Figure 1, and
choose the Close option.

4.4

*'1—2’2 Eil-—

Figure 4

Use the follwing steps to edit the spline in the Figure
3, to create the spline in Figure 4.

Note: Turn the ORTHO “ON?”, to define the tangent
directions.
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SPLINEDIT Command

o} Modify II [

o] Modify » Object » Spline

Select a spline to edit, right-click in the drawing area,
and choose Spline Edit.

E= splinedit
Command: spe <Enter>
SPLINEDIT
Select spline:

Enter an option [Fit data/Close/Move vertex/Refine/rEverse/Undo]: F <Enter>

Enter a fit data option

[Add/Close/Delete/Move/Purge/Tangents/toLerance/eXit] <eXit>: T <Enter>

Specify start tangent or [System default]: <Ortho on> {pick a point to define a new direction}
Specify end tangent or [System default]: {pick a point to define a new direction}

Enter a fit data option

[Add/Close/Delete/Move/Purge/Tangents/toLerance/eXit] <eXit>: X <Enter>

Enter an option [Fit data/Close/Move vertex/Refine/rEverse/Undo]: <Enter>

Exercise 3-1.
Use SPILNE and other commands, such as ELLIPSE, MIRROR, and OFFSET, to design an

architectural door knocker similar to the one shown. Use an appropriate text font to place your
initials in the center.

18
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Exercise 3-2. (Problem page 516)

Draw a spline similar to the original spline shown below. Copy the spline seven times to create a
layout similar to one given. Perform the SPLINEDIT (SPE) operation identified under each of
the seven copies.

3,4 24
5.5 Close Option
2,2 4,2 *
Original Spline
Move a Control Point Elevate the Order to 10

=

Delete a Control Point

V)

Increase the Weight of a Control
Point to 4

Add Two Control Points

Edit the Tangents

19
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Exercise 3-3
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rR3/B TYF. \h

AutoCAD

R1/2 l t ¥
\ | T
i
——7———{/—————;—@—49—#- - - - 20.3125 24 UNF—2A
: | . — o .50 DEEP 2 PLACES
SECTION B-B
FARALLEL LINES R3/4
8 7/16 ﬂm
R1/4 B -
/’" /—R3/16
R1/2 \ ah
L]
w© £ . =
= -, @
+/D—\{_ 539\ ki = =
A e R L 1/277
L ~ " SN l il S A%ﬂ 13/16 — 1 15/16
o ™ [ |
7 } ; 4 =2 ﬁ \ 4"y VIEW FROM A-A
THK. 1/8 R7 /8
[EALE ™ NOTE:
5 3/16
5 13,16 ALL UNMARKED ROUNDS
I — & FILLETS R .125
& 3/16
Exercise 3-4

Use the POLYLINE command to construct the frame, the LINE for the spokes and

DONUT for the tires. Use grid spacing 0.25.

s -

i

el T 4

21
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Lesson 4
Advanced Dimensions

'/O/z

o) Multileader

o) Styles

o} Format » Multileader Style

o) Multileaders panel, Multileader Style Manager
EE mleaderstyle

MLEADER with BUBBLES
1. To create a new multi-leader style, start the MLEADERSTYLE command:
a. From the Format menu, choose Multileadr Style.
b. Atthe * Command:” prompt, enter mleader command.

c. Inthe dashboard, or from the Multileader toolbar, choose the Multileader Style
button.

d. Or, atthe * Command:” prompt, enter mls alias.
2. To create a new style click New.

3. Enter the name for the style. For this exercise, enter “Round Bubble,” and then click
Continue.

4. Since we want to change the content of the mleader, choose the Content tab.
5. From the Multileader Type drop list, select Block.

6. Notice that the dialog box changes to show options related to the blocks. From the Source
Block drop list, select Circle.

7. Click OK to exit the first dialog boix. Click Set Current to make this new style current.
Click Close to exit the second dialog box.

22




p

AutoCAD Workbook I

o] Multileader

] Dimension » Multileader

£ Multileaders panel, Multileader
& mleader

8. Use the MLEADER command to place muliteader with the new style.

Command: mleader <Enter>

Specify leader arrowhead location or [leader Landing first/Content

first/Options] <Options>: {pick a point.}

Specify leader landing location: {pick another point}

Enter attribute values

Enter tag number <TAGNUMBER>: 1 <Enter>

ALTERNATIVE METHOD:

9. Press Ctrl + 3 to open the Tool Palettes window.

10. Pick the leaders Tab from the left of the tool palettes set. (Figure 10)

11. Construct the following figures:

LEADER
WITH WO TEXT

LEADER - CIRCLE

LEADER —=LOT

LEADER
WITH TEXT | FADER - POX

LEADER -HEX | EADER -TRIAMGLE

LEADER -DETAIL

23
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Imperial samples

(1] .
- Leader with no
]
E 4_ Lext
iy o
=} fi}
m =hi —_—
= v Auto-hide 4’5 Leader with bext
Transparency...
E k] New Palstte o 4’% Leader - Circle
& £ Rename
kel
2 E * Cuskomize Palekte 4% Leader - Box
E :I 1 Cuskamize Cam.
— 1
ol | Annotation and C Leader
I - Hex.
z il | 3D Make
g ': i Tahles
OR o : {J% Leadet - Triangle
=
7 Right-click a ' Materials
T here g [ Generic Lights 4’% Leader - Slok
= =8 ¢  Photometric Light
— 4 i Cameras Leader -
Wisual Styles Detail Eubble
. I AllPalettes
Figure 7

DIMENSIONING
Alternate Practices - Arrowless Dimensions

o X

ol

£ Menu: Dimension » Ordinate

£ Toolbar: Dimension

EE command entry: dimordinate

Ordinate dimensions measure the perpendicular distance from an origin point called the datum to
a feature, such as a hole in a part. These dimensions prevent escalating errors by maintaining
accurate offsets of the features from the datum.

Ordinate dimensions consist of an X or Y value with a leader line. X-datum ordinate
dimensions measure the distance of a feature from the datum along the X axis. Y-datum
ordinate dimensions measure the distance along the Y axis.

0.00

Y u-n:linate;l_
X u{uinat94‘

00

0.

24
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Locate the Datum:

The location and orientation of the current UCS determines the ordinate values. Before
creating ordinate dimensions, you typically set the UCS origin to coincide with the
datum.

UICS origin—. +
‘\\ 143

0.00—

(=]
=
i

Q.00

Exercise 4-2

Complete the drawing shown in Figure 10. Follow the steps below to add the
dimensions.

1. From Pull-down menu, Tools, select New UCS, Origin.

2. Define the new origin by picking the exact location at the lower left corner of the
part. (Figure 11)

3. From the”View “, “Display”, UCS Icon Uncheck the “On” option. You may do
this by typing the UCSICON from the Command line.

4. Place all the center marks, and check for other appropriate dimension settings.

5. Use the “Ordinate Dimension” to add the dimensions.
1 % i3] Ts]
‘ 4
2568 —
3,188
A A
2825 —
2250
!"‘\C
1.813 o)
B
@7 1.313
813 ~C HOLE | QTY DIAMETER
4 LW
S00 — \ / — 500 A 2 500
oo B 1 375
C 2 .250
Mew 2 o E o
Origin g B - % §_ a2
[an] =+ =+
Figure 8
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Exercise 4-3
82 % ¢ > 38 2 g8
Mo T | o= Toa
3.80 |
L
320
ZH3
HOLE] SIZE
4 3]
2.00 - —
1.55 o o4
1.06 o J40 ¥ 280
e E .50

MATL — ZAE 1008
012 THICE

B

COkM BMD: LICE
CRONATE Dimensicning

1.38

Z.00
2,36

]
o =
My = =
—

—

Start the center at 5.25,3.125

Figure 9
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Lesson 5
Dimensions with Tolerance

Lateral tolerances are values indicating the amount a measured distance can vary. You can
control whether lateral tolerances are displayed and you can choose from several styles of lateral
tolerances.

A lateral tolerance specifies the amount by which a dimension can vary. By specifying tolerances
in manufacturing, you can control the degree of accuracy needed for a feature. A feature is some
aspect of a part, such as a point, line, axis, or surface.

You can apply tolerances directly to a dimension by appending the tolerances to the dimension
text. These dimension tolerances indicate the largest and smallest permissible size of the
dimension. You can also apply geometric tolerances, which indicate deviations of form, profile,
orientation, location, and runout.

Lateral tolerances can be specified from theoretically exact measurements. These are called basic
dimensions and have a box drawn around them.

If the dimension value can vary in both directions, the plus and minus values you supply are
appended to the dimension value as deviation tolerances. If the deviation tolerance values are
equal, they are displayed with a * sign and they are known as symmetrical. Otherwise, the plus
value goes above the minus value.

— P — -

- 5750 |- |- 10,50 =a0s -
deviation tolerance symmefrical deviation
tolerance

If the tolerances are applied as limits, the program uses the plus and minus values you supply to
calculate a maximum and minimum value. These values replace the dimension value. If you
specify limits, the upper limit goes above the lower.

Format Lateral Dimension

You can control the vertical placement of tolerance values relative to the main dimension text.
Tolerances can align with the top, middle, or bottom of the dimension text.

27
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qE..Sf"f:a":!' 1100400 12.83 sn.08

= o
2 /

top middle bottom

Along with vertical placement of tolerance values, you can also control the horizontal alignment
of the upper and lower tolerance values. The upper and lower tolerance values can be aligned
using either the operational symbols or decimal separators.

— 1100409 1100199
W ///

% Z
operational symbols decimal separators

You can also control zero suppression as you can with the primary and alternate units.
Suppressing zeros in lateral tolerances has the same effect as suppressing them in the primary and
alternate units. If you suppress leading zeros, 0.5 becomes .5, and if you suppress trailing zeros,
0.5000 becomes 0.5.

To specify methods for lateral tolerances

1. Enter dimstyle at the command prompt.
2. Inthe Dimension Style Manager, select the style you want to change. Click Modify.
3. Inthe Modify Dimension Style dialog box, Tolerances tab, under Tolerance Format,
select a method from the Method list, and then do one of the following:
o If you select Limits, enter upper and lower tolerance deviation in the Upper
Value and Lower Value boxes.
o If you select Symmetrical tolerances, Lower Value is not available, because you
need only one tolerance value.
o If you select Basic, enter a value in Offset from Dim Line (on the Text tab) to
represent the gap between the text and its enclosing box.
4. Click OK.
5. Click Close to exit the Dimension Style Manager.

&
% Toolbar: Dimension or Styles

E command entry: DIMSTYLE
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[ Y Modify Dimension Style: Standard

Primary Units | &lkernate Units | T olerances |

Lingz || Symbolz and Arrowes | Test Fit

Talerance format
Method: ILimits l * v| . %m
Precision 0.0000 v| f
B
Upper walue; 0.0500 - ) @
: 0.0500 “<
Lower value: [ J - | o >\
Pl Ro.7845

Scaling for height; 1.000d :

Wertical position: | Middle b |
' Alternate unit tolerance
Talerance alignment
() Align decimal separators Frecizior:

() Aligh operational symbolz
£ e Lppression

Zel0 sUppression

[]Leading
[ Trailing

k. l [ Cancel ] [ Help

Figure 10

L 15500 ]

1.4500
O

Figure 11
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[ Modify Dimension Style: Standard @
Linez | Spmbolz and Amows || Test | Fit Frimary Unitz || Alternate Llnits| Talerances |
Tolerance format t\
Method T
Precision 0.0000 * v |

pper walue: 0.0500
Lanwer value: Iil

Scaling for height: 1.0000 :

Wertical pozition: | kiddle b |

' Alternate unit tolerance
Tolerance alignment

Precizion:
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£ ZLppression

[]Leading

[ ] Trailing

] l [ Cancel ] [ Help

- ——1.5000+.0500

- ~—1.5000+0.0500

5 O

Leading box checked
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Primary Uitz || &lternate Llnits| Tolerances |

Tolerance format

Scaling for height:
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Precision 0.0000 v |
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Primary Units || &lternate Llnits| Tolerances |

Talerance farmat

Scaling for height:

Method | E—
Precizion /

Upper walue:

Lover walue:

Vertical position: | biddle

Tolerance alignment

£l Uppression

&3

»
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1.1866

Alternate unit tolerance
Precizion:
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k. l [ Cancel ] [ Help
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Exercises

Draw and dimension necessary views for the following drawings to exact sizes. These problems
presented in isometric. Draw the proper orthographic (2D) views for each.

A. Apply dimensions accurately using ASME standards. Create dimension styles that suit
the specific needs of each drawing.

B. Create separate layers for the object lines and dimensions.

C. Assign the line weight of 0.6 mm for the object lines and default line weight for other
lines.

D. Place the following general notes in the lower left corner of the each drawing :

“NOTE:

a. UNLESS OTHERWISE SPECIFIED, ALL DIMENSIONS ARE IN
MILLIMETERS (or INCHES, as applicable)
b. REMOVE ALL BURRS AND SHRP EDGES.
c. INTERPRET PER ASME Y14.5M-1994"
E. Save the drawing.

1.494
1.497

(7]

Figure 12
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S@0.5625

@0.3750 FLAT
@0.2500 £.001
¥ .40
Figure 13
o |._6.0
5.8
- 20+£.3

o
AN

9386 ~—ut/

-

40 4 528
@555 >

Figure 14
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1. Start a new drawing or use one of your templates.
2. Draw the figure 18 with the given dimensions. Follow the steps below to add the dimensions
as shown in Figure 19.

t @36

76 -
! D66
4% 76
el 1gt00
4y PEH0 2 04
|$|@.z@|ﬁlﬁ®lf3®\ P
O +1
+1.0 ’
7 R B G N R &
l \\h /
|~ |
METRIC
Figure 15 04
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Adjust the following settings under the “Standard” dimension

style:

Fit: Overall Scale = 25.4 —=18 [~
Primary units: Decimal -Check Trailing box ey
Text Height: 0.125

Add the linear dimension 1 as shown. | _ |

Create a new dimension style and set the following dimension

variables: -1
[ 3 Dimension 5tyle Manager @
Current dimenzion style; Standard
Shyles: Fresiew of: Standard
Ay Annotative Set Current
Standard —_—
26,8039 /J New..| |
: -~
30.3657
7y AR
ar
[ N
R20.4355
List: Dezcription
Standard

All gtylez w

Cloze ]

Help
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L3 Create New Dimension Style m

Mew Style Mame:
“ Tol ] | Continue
Start With:
| Standard b’ |

Hel
[ ] &nnatative | i w
Lze far:
|.ﬁ.ll dimensions b |
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Y Modify Dimension Style: Tol-1

Lines | Symbaols and Aroves | Test Fit Primary Unitz | Altermate Llnits| Tolerances |
Talerance farmat \
i ethiod: /',| Deviation - | ™ “‘“"ﬁ =
Precizion | 0o w | I
R
-4 He
s 7 el
/ g
Lower walue: 0.4 = {
/ raoraz
Scaling far height: 1 :
Wertical position: | hdiddle w |
. Alternate unit tolerance
\T olerance alignrment
(%) Align decimal separators Frecisiorn:
() Align operational symbols
ZEI0 sUPPression
ZeI0 SUppression i
Leading [ feet
[ Leading 0 feet
[ Trailing 0 inches el D FEs
0k ] [ Cancel ] [ Help
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a. Click on OK, set the Tol-1
as a current dimension
style, add dimension 2, 3
and 4 as shown.

b. Set the “Standard” as a
current dimension style
and add dimension 1 as
shown.

c. Create a new dimension style
change the tolerance method to
Basic. Click OK.

d. Set“Tol-2” as current dime style
and add a linear dimension 5.

@

|
/?\
\TL/

+0.0

+0.0
18704

y 66 g y

&

FO

METRIC

Y Create New Dimension Style

M ew Style Manme:
Tal-2

»
Start With:\
Standard w
[ ] Annotative | i
Ilze for;
All dimensions w

]

/-

Help
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Y Modify Dimension Style: Tol-1 E]

Lines | Symbal: and Arrowes | Test || Fit Primary Units | Alternate Llnit$| Tolerances

Tolerance format

M ethod:

Precizion /

pper walue:

3
R Q y
Lower value: EE |
R |
9

[am.14]

Scaling for height:

Wertical position: | Middle

) Alternate unit tolerance
Tolerance alignment

Precigion:

ZeM0 SLpPrezsion

FEI0 ZUppression

?“ ok | | Cancel | | Hebp

-6 -
1
Ry ——éﬁ)—- 41
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e. Create a new dimension style change the tolerance
method to Symmetrical. Click OK. @

f.  Set“Tol-3" as current dime style and add a b0, 2 )10
diameter dimension 6. \ 0.4

g. Use the Ed command to add “4X” to the diameter i

#6. @ %L\
G G

|
I
|

[ Y Create New Dimension Style @

Mew Style MName:
Told \ P

Start ‘with:

Caticel
Tal-2 w
[ ] Annatative | i Help
Uze far:
All dimenzions L
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]

| Lines || Symbols and Srrows || Text || Fit

|| Prirmary Urits || Alternate Units| Talerances

Tolerance format

M ethod: /| Symmetrical v| —= A5AEAR00 [
Precizion | n.o w |
EBA AL
Y
/
RM. T 00
Scaling for height: 1 Y
Yertical pozition: | Middle b |
) Alternate unit talerance
Tolerance alignment
Align decimal separators Pracizian:
Align operational symbols
Zero sUppression
ZEI0 SUPPIEssian _
Leading [ feet
[ Leading 0 feet
- : Traili Qinch
] Trailing 0 inches \ railing inches
[ ar. l [ Cancel ] [ Help
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Lesson 6
Geometric Dimension and Tolerance

£ Toolbar: Dimension @EI

£ Menu: ‘ *=Dimension » Tolerance

B command entry: tolerance

Tolerance command displays the geometric characteristic symbols for location,
orientation, form, profile, and runout.

Follow the steps below to add a feature control frame follow the steps below:

From the command line type tol and press enter.

[ Y Geometric Tolerance F§|

\S_I,Im \Eer cel 4§ Tolerance2 \Datum1 \Dat%E \‘Datu\3
B H:-: |8 N - W8 c @
|‘ H HN I NNl N .

Height | | Projected Tolerance Zane: [}

Dratumn |dentifier:

}‘DK || cancel || Heb |

Place the control frame box # 7 as shown.
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4x @60.2 @

4 [ @0.20d8 | A |BM | COD

O,

i
t
>

O,

+0.0
76 04

o

6o

[ Multileader. Style Manager, @

Current multileader style: Standard
Styles: Presiew af: Standard

A Annotative Set Current

A7

Standard

Mew

II

| |
=
o
=
!

Lizt:
Al Styles w

[ Cloze l [ Help
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[N Modify Multileader Style: Standard @

Leader Format | Leader Structure | Content

Congtraints

b axirmum leader points 2 S
[ First segment angle

[]Second segment angle

\Landing zethings

[] Awtamatically include landing

Set landing diztance

o 2]

Scale

[ ] &nnatative |1
(7 Scale multileaders ta lapout

(%) Specify scale; a5 4 x

i Learn about Multleader Styles [ Ok, l [ Cancel ][ Help ]

[ Modify Multileader, Style: Standard E]

m| Leader Structure | Content
General
Type: [straight
Calar: | M EyEBlock w |
Linetype: | ByBlock, w |
Lineweight; | BuBlock b |
Arrowhead
Symbal: | =1 Datum triangle A |
Sizer n1g e
Leader break
Break size:

i Learn about Multleader Styles [ OF. l [ Cancel ][ Help
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[ Modify Multileader, Style: Standard

Leader Format LeaderStructure| Cantent |

bultileader type: | Maone e

i Learn about Multleader Styles OF. l [ Cancel ][ Help
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[ Geometric Tolerance [‘5_<|

Sym Tolerance 1 Tolerance 2 Cratum 1 Dratum 2 Dratum 3

EE HENR I () G
E R HENR /W N[ .

Height: |:| Projected Talerance £one: .
Dratum |dentifier:

/[ k. H Cancel H Help ]
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Lesson 7
Isometric Drawings

5 @
ol
AR
; O\ gl O] |
g B
e s L e
AT ﬁ‘ Iy
L iy e
A L :
é’?t%' :
iy AL _\3 gt
R i

The keyboard entry to enable isometric mode is as follows:

Command: snap <Enter>

Specify snap spacing or [ON/OFF /Aspect/Style/Type| <0.5000>: s
<Enter>

Enter snap grid style [Standard /Isometric] <S>: i

Specify vertical spacing <0.5000>: <Enter>

Or, the Drafting Settings dialog box allows you to make settings needed
for isometric drawing:
Note:

To switch between the isometric planes, use the F5 Key, or the
[Ctrl] + [E] key combinations.
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RA Drafting Settings

snap and Grid |F'n:n|ar Tracking || Object Shap|| Dynamic [nput

[]5nap OnFY] [] Grid On [F7)

Snhap spacing Gnid spacing

Shap % spacing; I:I (Grid = spacing: I:I

Snap ' zpacing: 1EZ0 Gnd Y spacing: 5000

b ajar line everny: 5 =
Falar zpacing Gnd behavior
I:I Adaptive gnd
[ ] Al subdivision below grid
Shap lpe Fpacing
(%) Grid zhap

Dizplay grid beyond Limitz
() Rectangular shap

- [ Fallow Dynamic LCS
(%) lsometric shap
\ Pick to activate

() PolarSnap

[ k. H Cancel H Help

To pace an isometric ellipse on the object use Isocircle of the ELLIPSE
command.

s
o

6f

Right

Soresn Crossiaans
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TEXT & Dimension on Isometric:

TEXT IN ISOMETRIC
CIMEMSION -IN [SOMETERIC -

DTS

Sl TR RO S

T Scale 1=1

Figure 16

6 25 THROUGH
L1758 125

Seale 1=1

Figure 17
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Figure 18
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Lesson 8; DIVIDE_POINT

£ Menu: Draw > Point » Divide

E command entry: divide

=

Draw a circle with 1.60 radius.

2. From format “point style” select the X
mark for point shape. (Figures A&B)

3. Dive the circle in 5 equal parts with

the DIVIDE Command (1)

4. Turn on the node object snap, and
connect the points with the LINE
command. (2)

5. Use the TRIM command as shown.
@)

6. ROTATE the entire object to the
position shown (4). Rotation base
is the center and the rotation angle
is 902 { If the Ortho is ON this can
be done easily withthe mouse
click.}

Im Tools  Draw  Dimension

¥ = Laver..
B Laver States Manager...
Laver tools 4
Calar. ..
Linetype, ..
Lineweight. ..

Scalg List...

&? Texk Skyle. ..

,.)f Dimension Style, .
ﬁ Table style. ..

;o) Multieader Style

Paint Style...

Multiline Style. ..

Figure A

@3.2]

1. DIVIDE 2 LIME

BN

3 TRIM 4+ ROTATE

@ Point Style

EEIE
EEEN
EEEE

INEEE
EEEE.

Poirt Size: | 5.0000

(&) Set Size Relative to Screen
() Set Size in Absolute Units

[ ak, H Cancel ][ Help

Figure B
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DIVIDE Command with block option.

Figure 20
BLOCKS & DIVIDE COMBMANDS

ROTATION 6L

GO0

AutoCAD Workbook I

10 K #1235
LI#5] %126
EQUALLY EPACET

Figure 21
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MINSERT Command

BLCK
"™ Geole Focter (58
SCALE: 1 = 2
CHak. 125 ¥ 45°
; +— ) —,
#1.00 - _{ + - T —
LA
—— | 5[] ——w 1.50
- 350 - |=— ZH

Figure 22

Create these electronic symbols, and then Ouse them on a schematic drawing using the INSERT
command:

Suggested Settings: Snap (0.05); Grid (0.05)

= .30 —

- |- 75 = 1.10 —

* Ll e

—VVVN— *

0D 20 ] 50
20 *
ESISTOR

CAPACITOR
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Figure 23
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Figure 24

PORCH ATTACH FILE "OFFICE” AS A ¥REF FILE.
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OFFICE % i S.C.431 CHAIR TAN
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= Y S.C.431 CHAIR _TAN
é S.C.431 CHAIR _TAN
— T&ELE
ENTRY N CHAIR CHAIR B
RECEPTION - |
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Creating a Dynamic Block

We’ll start with the shape of a twin-size bed and add parameter and action that will allow
its length and width to be stretched into a bed of any size.

1. Start AutoCAD and start a new drawing with default units.

2. Using the LIMITS command set the drawing area to 120 X100 and ZOOM All.

3. Create the top view of a twin-size bed using dimension shown in Figurel. Do not include
the dimensions in your drawing. These are standard dimension for a twin-bed.

75.00

»{ 1400

35.00

Figure 25
4. Name the drawing bed.dwg.
5. Pick the Make Block button from the Draw toolbar or enter the BLOCK command to

display the Block Definition dialog box.

6. Name the block Bed, pick the lower left corner of the bed for the base point, and select
the entire bed to be included in the block.

7. Near the bottom of the dialog box, check Open in block editor box.

8. Pick OK to close the dialog box and open the new block in the block editor.

Assigning Parameter to the Block

1. Inthe block Authoring Pallets window, select the parameters tab if it is not already

selected.

From the available options, pick Linear Parameter.

3. Pick the bottom left corner of the bed as the start point and bottom right corner of the bed
as the endpoint. Be sure to snap accurately to these two points.

4. Indicate a point inside the bed for the label location, as shown in Figure 2.

N

Tnlstnnca‘l

i
v

Figure 26
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Notice that parameter is automatically labeled “Distance”. Also notice the yellow icon with
exclamation mark near the lower left corner of the bed. This symbol means that parameter is
not currently associated with any action. You will set up the actions later. First, let’s create a
second parameter.

5. From the block Authoring Pallets window, pick “Linear Parameter” again. This time,
pick the lower left corner as the start point and the upper left corner for the endpoint.
Place the label inside the bed, as shown in Figure 3.

Distance2

Distoncel

el
v

Figure 27

6. Select the first Distance Parameter you created, right-click to display the shortcut menu,
and pick Rename, and press Enter.

7. Highlight the word Distance, enter Length for the new name, and press Enter.

8. Select the Distance 1 parameter and rename it Width.

NOTE: You can also nhame parameters at the time you create them. Before you specify the
parameter, Press “N” to enter the Name option.

9. Pick the Length parameter, right-click, and select Grip Display.
10. Pick a Grip Display of 1.

11. Change the Grip Display of Width parameter to 1.

12. Save your work.

Width

Length
]

)i, E==

Figure 28

Assigning Actions to the Parameters

The two parameters that you have established will allow you to adjust both the length and
the width of the dynamic block named Bed. Next, we will set up the action to be associated
with each parameter.

1. Expand the Action Parameters panel on the Block Editor tab or Ribbon and select the
Show All Action button.
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Note: You can also define an Action using the Action tab of the Block Authoring Pallets
window.

2. Pick the down-facing arrow below the Move button on the Action Parameters panel, and
select the Linear action button from the fly-out menu.

3. Select the Length parameter.

Notice that a red symbol appears at the lower right corner of the bed.

4. Pick the point in the lower right corner of the bed as the parameter point to associate with
the action.

5. Inreply to Specify first corner of stretch frame, use a standard crossing window (right to
left selection). Place the widow as shown in Figure. Be sure to include the interior line
that represents the bed covers in the crossing window.

6. At the Select Objects prompt use another crossing window to select roughly the same
area. Press ENTER when you are finished.

7. Pick the Stretch action icon, right-click, and pick Rename Action.

8. Rename the action Stretch length.

Length

[

]

!

]

]

]

]

]

Width E
]

'

]

. -
]

Figure 29

Next, we will define the action needed to change the width of the bed.
9. Pick the Stretch button again and select the width parameter.
10. Pick the endpoint at the upper left corner as the parameter point to associate with the
action.
11. For the stretch frame, place a crossing window across the upper half of the bed, as shown
in Fig. 5.
12. At the Select object prompt, use another crossing window to select roughly the same
area. Press ENTER when you are finished.
13. Rename the action to Stretch Width.
The Length and width parameters are now completely defined, so the alert icons for the
parameters have disappeared. Your block should now look similar to the one in Fig. 34-6.
14. Pick the Close Block Editor button on the Close panel of the Ribbon to return to the
AutoCAD window.
15. Pick Yes when prompted to save changes to the Bed block.
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Figure 30

Using Dynamic Blocks

The Bed block should now appear in AutoCAD’s drawing area. Next, we will change the
parameters of the block to change the size of the inserted block.
1- Select the Bed block.
Notice the arrows that appear instead of grip boxes at the upper left and lower right corners of the
bed. These arrows indicate changeable parameters.
2- Pick the arrow at the lower right corner of the bed and notice that it becomes active (red)
just as a grip would.
The Length parameter appears and an edit box appears to show the current length of the bed,
which is 75 inches.
3- Move the crosshairs and notice that the length of the bed changed dynamically.
4- At the keyboard, enter a new length of 80 and press ENTER to change the length of the
bed to 80 inches.
The bed updates automatically. This is the standard length for a queen-size, king-size, or extra-
long twin- size bed. Let’s change the width dimension to create a queen-size bed, which has a
standard width of 60 inches.
5- Select the bed again.
6- Pick the arrow at the upper left corner of the bed.
7- Enter a new width of 60.
Once again, the bed block automatically updates when you press ENTER.

Constraining parameters
It may have occurred to you that it is possible to change the dynamic Bed block to any length and

width using the dynamic block defined in the previous procedure. In real life, beds are usually
made to standard dimensions, as shown in Fig. 7.
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TWIN EXTRA LONG TWIN
39 X 75 39 X 80
CAL. KING
FULL
QUEEN
60 X 80 72 X 84 54 X 75

KING
SPLIT KING

76 X 80 78 X 80
Figure 31

Creating a Value Set

AutoCAD makes it easy to constrain, or limit, the choices that can be used for a given parameter.
You can do this by creating a value set for the parameter. For example, the three standard lengths
for a bed are 75, 80, and 84 inches. The following steps constrain the length parameter of the Bed
block using a value set that contains these three values.

1- Double-click the block to display the Edit Block Definition dialog box.

2- Select Bed and pick OK to enter the block editor.

3- Select the length parameter.

4- Select the Properties button from the Palettes panel on the view tab of the Ribbon.
This displays the properties of the linear parameter in the properties palette.

5- Near the bottom of the Properties palette, find the Value Set section and click to activate

the box next to Dist type. (You may need to scroll down to find this section.)

6- Pick the down arrow and then pick List from the options that appear.
Notice that the next row, Dist value list, now shows 75.0000. This is the value you used when
you originally created the block, and it becomes the default value.

7- Pick to activate the Dist value list row and pick the three dots to the right of the edit box.

Distances ko add:
!

75,0000
80,0000
84.0000

Distance  |75,0000
angle 0

Conskrainks

| Yalue Set -
Dist type

(7]
-% SERTE 75.0000 | T
@
g |Mi5c - 'h
=" Base loc... |Skartpoint
Show Pr...
Yes 0K ] [ Cancel l [ Help ]

This displays the Add Distance Value dialog box.
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8- In the Distances to add edit box, enter 80 and pick the Add button.

The new value of 80.0000 appears in the window below the edit box.

9- With the cursor still active in the Distances to add edit box, enter 84 and pick the Add
button to add 84.0000 to the list.

10- Pick OK to close the dialog box.

11- Press ESC to deselect the Length parameter.

The standard widths for beds are 39, 54, 60, 72, 76 and 78. Let’s constrain the Width parameter
to these values.

12- With the properties palette still open, pick to select the Width parameter.

13- In the Dist type row in the Properties palette, change the value to List.

14- Click to activate the Dist value list row and pick the button with three dots to display the
Add Distance Value dialog box.

Once again, the default value appears in the window.

15- Add the other standard width values: 54, 60, 72, 76 and 78. Pick OK when you are
finished.

16- Close the properties palette and save the file. If AutoCAD displays a message asking
whether you want to save the drawing and update the existing block definition in the
drawing, pick Yes.

17- Close the block editor.

Using a Constrained Block

Constrained blocks can be altered on-screen in the same way as unconstrained dynamic blocks.
The only difference is that, when you pick one of the parameter arrows, small tick marks appear
to mark the valid values for the parameter.

1. Select the Bed block to display the parameter arrows.
2. Pick the lower right parameter arrow so that it turns red.

Just below the arrow, notice the faint tick markers on either side of current bed length. See
Figure 8.

You may recall that the bed is currently configured with dimensions for a queen-size bed: 60 X
80 inches. The 80 inches is one of the three standard values. The two tick mark the other two
values allowed for the Length parameter: 75 and 84. Let’s change the Bed block to represent a
full-size bed (54 x 75 inches).

3. Move the cursor to the left and notice that a tentative line appears at the 75-inch thick
mark.

4. Pick any point while that line is present to reset the length of the bed to 75 inches.

5. Pick the upper left parameter arrow to activate the Width parameter and notice the tick
marks representing allowed values.

The current value of 60 shows up in the edit box for reference.

6. Move the cursor down until the edit box shows a value of 54 and pick any point to
change the width of the bed to 54 inches.

The block is now configured to represent a full-size bed.

If you enter undefined value into the edit box for constrained parameter, AutoCAD automatically
chooses the defined value that is closest to the value you entered. For Example, if you entered a
value of 63 for the Width parameter, the width of the bed would change to 60, which is the
closest defined value set.
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Analyzing 2D drawings, using AutoCAD’s INQUIRY features:
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Figure 32

Calculate the surface area
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ROTOR
1. The absolute coordinate value of the center of hole "A" is closest to
2. The perimeter of Rotor is
3. The distance from the center of arc "B" to the center of arc "C" is
4. The absolute coordinate value of the center of arc "D" is closest to
5. The total length of arc "F" is
6. The total area of Rotor with all four holes removed is
7. Change the diameter of all three 1.000 diameter holes to 0.700 diameters.

Change the diameter of the 2.550 hole to a new diameter of 1.625. The new area
of Rotor with all four holes removed is

R2.375

3X¢1.000

EQ. SPACED
START CENTER AT R125
11.125,9.225 FOR ALL CORNERS

Figure 33
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Control Bearing

Start Point: Center at 11.5, 11.5.

The distance from center arc “A” to the intersection at “B” is

The total length of arc “C” is

The perimeter of inner slot “G” is

The absolute coordinate value of the center of the 0.44 diameter hole “F” is

The perimeter of the outmost shape of the Control Bearing is

The angled formed the XY plane from the intersection at “D” to the center of the arc “E”
is

7. The area of the Control Bearing with all holes and inner slot removed is
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3.00 © | ‘
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Figure 34
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Additional problems
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Figure 35
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